DMTF Template

Information for Work-in-Progress version:

IMPORTANT: This document is not a standard. It does not necessarily reflect the views of the DMTF or all of its members. Because this document is a Work in Progress, it may still change, perhaps profoundly. This document is available for public review and comment until the stated expiration date.

It expires on: <yyyy-mm-dd>

Provide any comments through the DMTF Feedback Portal:
http://www.dmtf.org/standards/feedback
DMTF is a not-for-profit association of industry members dedicated to promoting enterprise and systems management and interoperability. Members and non-members may reproduce DMTF specifications and documents, provided that correct attribution is given. As DMTF specifications may be revised from time to time, the particular version and release date should always be noted.

Implementation of certain elements of this standard or proposed standard may be subject to third party patent rights, including provisional patent rights (herein "patent rights"). DMTF makes no representations to users of the standard as to the existence of such rights, and is not responsible to recognize, disclose, or identify any or all such third party patent right, owners or claimants, nor for any incomplete or inaccurate identification or disclosure of such rights, owners or claimants. DMTF shall have no liability to any party, in any manner or circumstance, under any legal theory whatsoever, for failure to recognize, disclose, or identify any such third party patent rights, or for such party's reliance on the standard or incorporation thereof in its product, protocols or testing procedures. DMTF shall have no liability to any party implementing such standard, whether such implementation is foreseeable or not, nor to any patent owner or claimant, and shall have no liability or responsibility for costs or losses incurred if a standard is withdrawn or modified after publication, and shall be indemnified and held harmless by any party implementing the standard from any and all claims of infringement by a patent owner for such implementations.

For information about patents held by third-parties which have notified the DMTF that, in their opinion, such patent may relate to or impact implementations of DMTF standards, visit http://www.dmtf.org/about/policies/disclosures.php.
Instructions — Delete Before Publication

1. How to use this template (general instructions)

1.1 General

Use this template for DMTF profiles based on the Management Profile Specification User Guide1.1(DSP1001), specifications, or white papers. These instructions explain how to use the template in Word 2007. Subsequent clauses explain how to modify the template for a profile, specification, or white paper.

1.2 Storing the template (.dotx) file

You must store this .dotx file in a certain folder to ensure that it is available through Word when you want to create a new document.

To determine where to store template files, follow these steps:

1) Click the Office button (upper left), and click the Word Options button.
2) In the left pane, click Advanced.
3) At the bottom of the dialog, click File Locations.
4) Select ”User templates” to see the path where Word stores and looks for templates.

This is the path where you should store the .dotx file. If you store the file in this directory, the next time you start Word and click the Office button → New and select Templates…my templates in the left pane, you can select this template to start a new document.

1.3 Ensuring that your document uses the template

To use the functionality provided by the template, use one of the following approaches:

• Start the new document by using the template (as described in 1.2 in these instructions).

• Attach the template file to a document (.doc) file. For instructions about how to attach the template and ensure that your document includes the styles used in the newly attached template, see 1.5 and 1.6 below.

1.4 Using the optional macros template

This subclause explains why and how to use the optional macros template.

1.4.1 Why use the optional macros template

A separate template (DSP1000macros_.m.n.u.dotm)that provides macros is available to use with this template. This optional macros template provides the following functionality:

• A streamlined method for inserting numbered captions for figures, tables, and equations

• A button to toggle line numbering on or off

• For styles such as Notes and Examples, the macros fill in the label (for example, NOTE or EXAMPLE) and provide automatic numbering for numbered notes or examples.
If automatic numbering is not working properly for your document, you can use one of the macros provided to reset heading and list numbering. (Click Misc. Commands → Reset Heading/List Numbering.)

**1.4.2 How to apply the optional macros template as a global template**

You can take advantage of the macros by applying the macros template (DSP1000macros_m.n.u.dotm) as a "global template" on top of this template (DSP1000_m.n.u.dotx); with this method, macros are not applied as a document template.

Macros from a document template are not copied into the new document to which the macros template is attached. However, when the macros template is applied as a global template, these macros become available.

After applying the macros template as a global template, enabling or disabling the macros for a document is as easy as turning the check mark on or off in the templates dialog. Having that checkmark turned off avoids prompts when opening and closing a document.

Selecting and enabling a global template affects any document currently open in Microsoft Word. Make sure to disable the DSP1000macros_m.n.u.dotm template before closing the document or closing Microsoft Word, or the macros template will affect any new document you start or open.

**1.4.2.1 Enable the DSP1000macros_m.n.u.dotm global template**

To use the macros, you must enable the macros template. Follow these steps:

1) Click the Office button (upper left), and then click the Word Options button.
2) In the left pane, click Add-Ins.
3) In the Manage pull-down menu at the bottom, select Templates and click Go...
4) Click Add …
5) Navigate to where the DSP1000macros_m.n.u.dotm template file is stored.
6) Select DSP1000macros_m.n.u.dotm, and click OK.
7) On the Templates and Add-ins dialog, click OK.

**1.4.2.2 Disable the DSP1000macros_m.n.u.dotm global template**

To disable the macros template, follow these steps:

1) Click the Office button (upper left), and then click the Word Options button.
2) In the left pane, click Add-Ins.
3) In the Manage pull-down menu at the bottom, select Templates and click Go...
4) Uncheck the checkbox for DSP1000macros_m.n.u.dotm, and click OK.

**1.5 Attaching the DSP1000_m.n.u.dotx template to an existing document**

1) Click the Office button (upper left), and then click the Word Options button.
2) In the left pane, click Add-Ins.
3) In the Manage pull-down menu at the bottom, select Templates and click Go...
4) Click the Attach button.
5) Select the appropriate .dotx file that you want to attach. (If you stored the .dotx file in the proper destination folder as described in 1.2 in these instructions, it should be listed among your
template files and you won’t have to browse for it.) Make sure the “Automatically update document styles” box is not checked.

6) Click OK.

1.6 Using the organizer to copy the template styles to your document

1) Click the Office button (upper left), and then click the Word Options button.
2) In the left pane, click Add-Ins.
3) In the Manage pull-down menu at the bottom, select Templates and click Go...
4) Click the Organizer button in the lower left corner of the dialog.
5) On the right side of the Organizer dialog box click Close File; this button label changes to Open File.
6) Click the Open File button.
7) Traverse to the correct directory and select the DMTF template. Click Open.
8) In the list of styles in the window on the right side (under the DMTF template name), click on the ”code” style (a few styles down from the top) and use the scroll bar to scroll down to the end of the list of styles. Hold down the shift key and click on “zzSTDTitle”. Click on the << Copy button. Select the “Yes to All” button when asked to overwrite existing styles.
9) Click Close.

1.7 Using the variables defined in the template

The template uses a number of fields associated with the document’s properties to populate elements in the title page, headers, footers, and other places in a document.

You can change the values for any of these fields by modifying the document’s properties. To change the value for a particular field, follow these steps:

1) Click the Office button (upper left), and then select Prepare → Properties.
2) Click the down arrow next to Document Properties and select Advanced Properties.
3) Click the Custom tab.
4) Click the name of the field in the Properties list in the bottom half of the dialog, and then modify the string in the Value field.
5) Click Modify to save the change.
6) Repeat steps 4 and 5 for each property whose value you want to change.
7) When you have finished modifying properties, click OK.

If you change a value for a field, the change will be propagated the next time you update the document. For details on updating the fields in a document, see 1.8 below.

All of the custom properties are listed in the following table:

<table>
<thead>
<tr>
<th>Custom Property (Variable) Name</th>
<th>Description</th>
<th>Used In</th>
</tr>
</thead>
<tbody>
<tr>
<td>DocTitle</td>
<td>Document title, which will be displayed on the title page and in the page headers</td>
<td>All documents</td>
</tr>
<tr>
<td>DocNumber</td>
<td>Document number, which will be displayed on the title page and in the page headers</td>
<td>All documents</td>
</tr>
<tr>
<td>Custom Property (Variable) Name</td>
<td>Description</td>
<td>Used In</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>DocVersion</td>
<td>Published version of the document, which will be displayed on the title page and in the page footers. See DSP4004 for guidelines about version numbers, including the conventions for specifying draft level with letters.</td>
<td>All documents</td>
</tr>
<tr>
<td>DocType</td>
<td>The document type, as follows: Use “Specification” for all standards documents (including profiles). Use “White Paper” for white papers. Use “Process” for process documents. This list is the subset of document types covered by this template. See DSP4004 for the complete list of document types.</td>
<td>All documents</td>
</tr>
<tr>
<td>DocStatus</td>
<td>This is the document status, which will be displayed on the title page and in the page footers (directly before the DocConfidentiality variable). The DocStatus values are as follows: In Development Work in Progress DMTF Draft Standard DMTF Standard DMTF Informational Specification DMTF Informational See DSP4004 for the complete list of values for this property.</td>
<td>All documents</td>
</tr>
<tr>
<td>DocLang</td>
<td>This property is the document language. For DMTF documents, the value for this property shall be “en-US” for U.S. English. (This value is a combination of language code as defined in ISO 639-1/2/3 and country code as defined in ISO 3166-1/2/3.)</td>
<td>All documents</td>
</tr>
<tr>
<td>DocConfidentiality</td>
<td>This property is displayed in the center of the page footers and directly follows the DocStatus property. During document development and the DMTF approval process, the value of this variable should be “DMTF Confidential “. For Work in Progress documents that are under development, this property should read: “– Not a DMTF Standard – DMTF Confidential”. After a document is released, the value of this variable should be an empty string, except for Work in Progress documents where the value should be: “– Not a DMTF Standard” (directly following the DocStatus value of “Work in Progress”; insert a space before the dash so the DocConfidentiality value works correctly with the DocStatus value).</td>
<td>All documents</td>
</tr>
</tbody>
</table>
1.8 Updating properties and fields in a document

You can update either a single value or all of the values for a document’s properties or fields.

1.8.1 To update the value for a single field

To update the value for a single field (for example, the version number in a page footer), follow these steps:

1) Select the text that you want to update.
2) Right click and select Update Field.

1.8.2 To update all of a document’s properties and fields

To update all of a document’s properties and fields (as well as the Table of Contents, Figures list, and Tables list), follow these steps:

1) Open the document.
2) Either press Ctrl-A or click three times in the left margin to highlight all of the text in the document.
3) Right click anywhere within the highlighted text and select Update Field.
4) Various windows are displayed that allow you to update either just the page numbers or both the page numbers and text in the various generated lists that are included in your document (Table of Contents, Figures list, and Tables list). To update these lists:
   - In the Update Table of Contents window that is displayed, select the Update entire table option.
   - In the Update Table of Figures window, select the Update entire table option.
   - In the Update Table of Tables window, select the Update entire table option.
5) Look for broken references by searching for “Error!” and correct them as needed.
1.9 Using bookmarks and hyperlinks for references to other documents

Within the body of a profile or specification, all references to other documents should be hyperlinked back to the list of references in Clause 2 ("Normative References") or to the Bibliography rather than to the actual source document on the Web. Each document in the reference list or Bibliography contains a URL with a hyperlink to the source document on the Web. The URL for each reference should be visible in each reference (for example, http://www.dmtf.org/standards/published_documents/DSP1033_1.0.pdf).

Links to actual documents (through URLs) should appear only in the list of references or the Bibliography. With this approach, updates to referenced documents' version, date, or URL need to be made in only one place.

To facilitate this approach, insert a bookmark for each document in the list of references. You can then add a hyperlink back to this bookmark from each reference in the body of the document. The following subclauses provide instructions for how to create bookmarks and hyperlinks, as well as conventions for bookmark names.

1.9.1 To add a bookmark

To add a bookmark, highlight the text (such as a document title) that you want to link to. Go to Insert → Bookmark. Provide a bookmark name according to the conventions described in 1.9.3 in these instructions.

1.9.2 To add a hyperlink

Hyperlinks can link either to a point within the document or to a document on the Web.

To add a hyperlink that references a point within the document (such as a document title within the list of normative references or in the Bibliography):

1) Highlight the document name or number where you want to insert a hyperlink.
2) Go to Insert → Hyperlink, and from the Link to: list on the left, select Place in This Document.
3) In the window, scroll to the bottom for the list of bookmarks that you can link to and select the appropriate bookmark.

To add a hyperlink that points to a document on the Web:

1) Highlight the document name or number for which you want to insert a link.
2) Go to Insert → Hyperlink, and from the Link to: list on the left, select Existing File or Web Page.
3) In the Address field near the bottom of the dialog, type or paste the destination URL for the document or Web site.

1.9.3 Conventions for bookmarks

Adhering to bookmark naming conventions facilitates copying/pasting of bookmark references from one document to another if the respective bookmark definition is already in the target document.

When creating bookmarks, use the following conventions for the bookmark name:

- Use "Ref_DMTF_DSPxxxx" for DMTF specifications.
- Use "Ref_<ORG>_xxxx" for non-DMTF specifications.
- Use "Term_<termword1>", "Term_<termword2>", etc. for terms and for symbols and abbreviated terms.

NOTE Do not include versions or dates in bookmark names.
2. Using this template to create a DMTF profile

This template is optimized for profile development using the *Management Profile Specification User Guide* DSP1001 1.1. To create a profile using this template, refer to DSP1001 ver 1.1 and follow these steps:

1. Fill in the variables (custom properties) as described in 1.7 in these instructions. Fill in the document title for the DocTitle field, and fill in values for all other fields that are not optional.

2. Delete the “Abstract” clause because it is used only for white papers.

3. Add or delete information in the “Foreword” and “Acknowledgments” sections as necessary.

4. Add or delete text in the “Introduction”.

5. Fill in text for the “Scope”.

6. In Clause 2, “Normative References”, insert any additional references that are needed, using the format of the references already included.

7. In Clause 3, add terms and definitions for your document.

8. In Clause 4, add any abbreviated terms and their spelled-out versions.

9. Fill in Clauses 5–10 according to DSP1001. Note that the fields in the beginning of Clause 5 will be filled in with the values you entered for the custom properties.

10. Use the Annex placeholder if you have material for one or more Annexes. In each Annex title, indicate whether the annex is Informative or Normative.

11. Fill in the Change Log to capture progress. The Change Log should include only one row for each published release. The Change Log should be the last Annex before the Bibliography.

12. Fill in any entries for the Bibliography. If you have no documents to include in the Bibliography, delete it. The Bibliography is not an annex and should not be labeled as an annex.

13. Delete the “Instructions” section (all of this green text).

14. If your document is not a Work in Progress, delete the Work in Progress box (visible in the Print Layout view) from the title page.

15. Update all fields in the document as described in 1.8.2 in these instructions.

3. Using this template to create a DMTF specification

Only the first few clauses (through Clause 4) and the Annexes/Bibliography of this template are relevant if you’re creating a DMTF specification. To create a specification using this template, follow these steps:

1. Fill in the variables (custom properties) as described in 1.7 in these instructions. Fill in the document title for the DocTitle field, and fill in values for all other fields that are not optional.

2. Delete the “Abstract” clause because it is used only for white papers.

3. Add or delete information in the “Foreword” and “Acknowledgments” sections as necessary.

4. Add or delete text in the “Introduction”.

5. Fill in text for the “Scope”.

6. In Clause 2 “Normative References,” delete any references that don’t apply. (The boilerplate list of references applies to DMTF management profiles, so some of these references might not be appropriate for your specification. Retain the reference to the ISO Directives because it applies to all DMTF documents.) Insert any additional references that are needed, using the format of the references already included.

7. In Clause 3, add terms and definitions for your document.
8) In Clause 4, add any abbreviated terms.

9) Delete Clauses 5–10, because they contain boilerplate text that is specific to profiles (based on DSP1001 1.1).

10) Use the Annex placeholder if you have material for one or more Annexes. In each Annex title, indicate whether it is Informative or Normative.

11) Fill in the Change Log to capture progress. The Change Log should include only one row for each published release. The Change Log should be the last Annex before the Bibliography.

12) Fill in any entries for the Bibliography. If you have no documents to include in the Bibliography, delete it. The Bibliography is not an annex and should not be labeled as an annex.

13) Delete the “Instructions” section (all of this green text).

14) If your document is not a Work in Progress, delete the Work in Progress box (visible in the Print Layout view) from the title page.

15) Update all fields in the document as described in section 1.8.2 in these instructions.

4. Using this template to create a DMTF white paper

Only the first few sections (through Clause 2) and the Annexes/Bibliography of this template are relevant if you’re creating a DMTF white paper. To create a white paper using this template, follow these steps:

1) Fill in the variables (custom properties) as described in 1.7 in these instructions. Fill in the document title for the DocTitle field, and fill in values for all other fields that are not optional.

2) In the “Abstract” section, briefly describe the purpose and the intended audience for the white paper.

3) Add or delete information in the “Foreword” and “Acknowledgments” sections as necessary.

4) Review the “Introduction” section, and delete any sections that aren’t relevant. If you use any document conventions, list them here. If you don’t use conventions, delete the “Document conventions” section.

5) Change the “Scope” heading to “Executive Summary”, and add summary information in this section. The Executive Summary should be no longer than one page.

6) Delete Clause 2 “Normative References”.

7) In Clause 2 (“Terms and definitions”), add terms and definitions for your document. Each term is a numbered subclause that is created by using the Term – Ref Num style (followed by the Term – Name and Term – Definition styles).

NOTE You must adjust the numbering of the first term so that the first part of the term heading number matches the number of the preceding clause. By default, the list of terms starts with 3.1 because the “Terms and definitions” clause is typically Clause 3. If your “Terms and definitions” clause is Clause 2, there will be a mismatch. To adjust this, right click in the first “numbered” paragraph under the “Terms and definitions” heading. Select “Numbering” and then select “Define New Number Format” from the list that pops up: change the first part of the number (3) to match the number of the preceding main clause (probably 2). Click OK. The first number of the term number should now match the preceding clause number.

8) In Clause 3 (“Symbols and abbreviated terms”), add acronyms or other abbreviations used in your document. Each abbreviation is a numbered subclause created by using the Term – Ref Num style (followed by the Term – Name and Term – Definition styles). Delete Clause 3 if you don’t have any symbols or abbreviated terms. (See NOTE above for a tip about numbering.)

9) Delete Clauses 4–10 because they contain boilerplate text that is specific to profiles (based on DSP1001 1.1).

10) Add new clause headings and clauses as necessary.
11) Use the Annex placeholder if you have material for one or more Annexes. In each Annex title, indicate whether it is Informative or Normative. Otherwise, delete the annex placeholder.

12) Fill in the Change Log to capture progress. The Change Log should include only one row for each published release. The Change Log should be the last Annex before the Bibliography.

13) Fill in any entries for the Bibliography. If you have no documents to include in the Bibliography, delete it. The Bibliography is not an annex and should not be labeled as an annex.

14) Delete the “Instructions” section (all of this green text).

15) If your document is not a Work in Progress, delete the Work in Progress box (visible in the Print Layout view) from the title page.

16) Update all fields in the document as described in 1.8.2 in these instructions.

5. Guideline for using capital letters in headings and figure and table titles

The Technical Committee recommends using sentence-style capitalization in headings, figure titles, and table titles. In other words, only the first letter of the heading or title should be a capital letter (except for class names and other words that use a capital letter regardless of the context).

6. Document footers

A document’s status dictates the text that should be included in a document’s page footers, as follows:

<table>
<thead>
<tr>
<th>Document status</th>
<th>Required text in footer</th>
</tr>
</thead>
<tbody>
<tr>
<td>In Development</td>
<td>In Development — DMTF Confidential</td>
</tr>
<tr>
<td>Work in Progress (in Development)</td>
<td>Work in Progress — Not a DMTF Standard — DMTF Confidential</td>
</tr>
<tr>
<td>Work in Progress (published)</td>
<td>Work in Progress — Not a DMTF Standard</td>
</tr>
<tr>
<td>DMTF Draft Standard</td>
<td>DMTF Draft Standard — DMTF Confidential</td>
</tr>
<tr>
<td>DMTF Standard</td>
<td>DMTF Standard</td>
</tr>
<tr>
<td>DMTF Informational Specification</td>
<td>This Informational Specification is not a DMTF Standard and may change.</td>
</tr>
<tr>
<td>DMTF Informational</td>
<td>DMTF Informational</td>
</tr>
</tbody>
</table>

7. Helpful Hints for Figures and Tables

7.1 Figures

Sometimes inserting .jpg files into a Word document yields fuzzy figures. For class diagrams and other figures, use this procedure so that your figures have higher resolution:

1) Select and copy the diagram from the .vsd file so that it’s on the clipboard.

2) In Word, with your cursor at the diagram insertion point, on the Home menu select the down arrow under Paste and select Paste Special.

3) Select Picture (Windows Metafile) or Picture (Enhanced Metafile), and then click OK.

4) Look at the inserted figure to be sure that it’s OK.

NOTE Use Enhanced Metafile if the .vsd image contains any special symbol-type characters. It takes more storage for enhanced metafiles, so that’s the drawback of using it. It doesn’t hurt to specify the Enhanced Metafile format if you’re not sure if the art, such as a class diagram, includes special characters.
7.2 Tables

This template contains a default table style called DMTF Table. It has the proper line weights and width pre-defined for typical DMTF tables. Sometimes, during the course of adding and deleting rows, the table formatting gets messed up. To automatically format a table using the DMTF Table table style, follow this procedure:

1) Select the table that you want to format. (This activates a new menu.)
2) Under Table Tools, click the Design tab.
3) In the Table Styles group, click the More button (down arrow with a line over it) and you will see a lot of tables. Scroll to the top of these tables and you will see a Custom label with one table under it. This is the DMTF Table style, though it's not obviously labeled as such.
4) Click this table style to apply it to the table.
5) In the Table Style Options group to the left of the Table Styles group, check all six checkboxes.

NOTE  The text in the table column headings should be bold. Although the DMTF Table style specifies bold text in headings, it doesn’t always work. You might have to highlight the table heading row and click the bold icon.

8. Template support

If you have questions about how to use this template or requests for updates, send an email to DMTF.Support@brightleafgroup.com.
Abstract

Provide a short statement (one paragraph) about what the white paper describes.

Provide a short statement (one paragraph) about the intended target audience of the white paper.
Foreword

The *DMTF Template* (DSP1000) was prepared by the <DMTF Editing Body> Working Group.

DMTF is a not-for-profit association of industry members dedicated to promoting enterprise and systems management and interoperability. For information about the DMTF, see [http://www.dmtf.org](http://www.dmtf.org).

Acknowledgments

The DMTF acknowledges the following individuals for their contributions to this document:

- <first name and last name> – <company name>
- <company name>
- <company name>
- <company name>

<List the editor or editors for the current release first, followed by each contributor’s name and company arranged in alphabetical order by contributors’ last names.>
Introduction

The information in this specification should be sufficient for a provider or consumer of this data to unambiguously identify the classes, properties, methods, and values that shall be instantiated to subscribe, advertise, produce, or consume an indication using the DMTF Common Information Model (CIM) Schema.

The target audience for this specification is implementers who are writing CIM-based providers or consumers of management interfaces that represent the components described in this document.

Document conventions

Typographical conventions

The following typographical conventions are used in this document:

- Document titles are marked in italics.
- ABNF rules are in monospaced font.

ABNF usage conventions

Format definitions in this document are specified using ABNF (see RFC5234), with the following deviations:

- Literal strings are to be interpreted as case-sensitive Unicode characters, as opposed to the definition in RFC5234 that interprets literal strings as case-insensitive US-ASCII characters.

Deprecated material

Deprecated material is not recommended for use in new development efforts. Existing and new implementations may use this material, but they shall move to the favored approach as soon as possible. CIM service shall implement any deprecated elements as required by this document in order to achieve backwards compatibility. Although CIM clients may use deprecated elements, they are directed to use the favored elements instead.

Deprecated material should contain references to the last published version that included the deprecated material as normative material and to a description of the favored approach.

The following typographical convention indicates deprecated material:

```
DEPRECATED
```

Deprecation material appears here.

```
DEPRECATED
```

In places where this typographical convention cannot be used (for example, tables or figures), the "DEPRECATED" label is used alone.

Experimental material

Experimental material has yet to receive sufficient review to satisfy the adoption requirements set forth by the DMTF. Experimental material is included in this document as an aid to implementers who are interested in likely future developments. Experimental material may change as implementation...
experience is gained. It is likely that experimental material will be included in an upcoming revision of the document. Until that time, experimental material is purely informational.

The following typographical convention indicates experimental material:

```
EXPERIMENTAL
```

Experimental material appears here.

```
EXPERIMENTAL
```

In places where this typographical convention cannot be used (for example, tables or figures), the "EXPERIMENTAL" label is used alone.
1 Scope

2 Normative references

The following referenced documents are indispensable for the application of this document. For dated or versioned references, only the edition cited (including any corrigenda or DMTF update versions) applies. For references without a date or version, the latest published edition of the referenced document (including any corrigenda or DMTF update versions) applies.

DMTF DSP0004, CIM Infrastructure Specification 2.7, [http://www.dmtf.org/standards/published_documents/DSP0004_2.7.pdf](http://www.dmtf.org/standards/published_documents/DSP0004_2.7.pdf)


DMTF DSP0223, Generic Operations 1.0, [http://www.dmtf.org/standards/published_documents/DSP0223_1.0.pdf](http://www.dmtf.org/standards/published_documents/DSP0223_1.0.pdf)


DMTF DSP1033, Profile Registration Profile 1.0, [http://www.dmtf.org/standards/published_documents/DSP1033_1.0.pdf](http://www.dmtf.org/standards/published_documents/DSP1033_1.0.pdf)


DMTF DSP1054, Indications Profile 1.2, [http://www.dmtf.org/standards/published_documents/DSP1054_1.2.pdf](http://www.dmtf.org/standards/published_documents/DSP1054_1.2.pdf)

DMTF DSP8016, WBEM Operations Message Registry 1.0, [http://schemas.dmtf.org/wbem/messageregistry/1/dsp8016_1.0.xml](http://schemas.dmtf.org/wbem/messageregistry/1/dsp8016_1.0.xml)

DMTF DSP8020, Message Registry XML Schema Specification 1.0, [http://www.dmtf.org/standards/published_documents/DSP8020_1.0.xsd](http://www.dmtf.org/standards/published_documents/DSP8020_1.0.xsd)


3 Terms and definitions

In this document, some terms have a specific meaning beyond the normal English meaning. Those terms are defined in this clause.

The terms "shall" ("required"), "shall not", "should" ("recommended"), "should not" ("not recommended"), "may," "need not" ("not required"), "can" and "cannot" in this document are to be interpreted as described in ISO/IEC Directives, Part 2, Annex H. The terms in parenthesis are alternatives for the preceding term, for use in exceptional cases when the preceding term cannot be used for linguistic reasons. Note that ISO/IEC Directives, Part 2, Annex H specifies additional alternatives. Occurrences of such additional alternatives shall be interpreted in their normal English meaning.

The terms "clause", "subclause", "paragraph", and "annex" in this document are to be interpreted as described in ISO/IEC Directives, Part 2, Clause 5.

The terms "normative" and "informative" in this document are to be interpreted as described in ISO/IEC Directives, Part 2, Clause 3. In this document, clauses, subclauses, or annexes labeled "(informative)" do not contain normative content. Notes and examples are always informative elements.

The terms defined in DSP0004, DSP0223, and DSP1001 apply to this document. The following additional terms are used in this document.

4 Symbols and abbreviated terms

The abbreviations defined in DSP0004, DSP0223, and DSP1001 apply to this document. The following additional abbreviations are used in this document.

5 Conformance
6 Synopsis

6.1 Profile attributes
Profile name: <RegisteredProfileName>
Version: 1.0.0
Organization: DMTF
Profile type:
Schema version:
Central class adaptation:
Scoping class adaptation:
Scoping algorithm:

6.2 Summary

6.3 Related profiles
Table 1 lists profiles that are related to this profile.

Table 1 – Related profiles

<table>
<thead>
<tr>
<th>Profile reference name</th>
<th>Profile name</th>
<th>Organization</th>
<th>Version</th>
<th>Relationship</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;profile reference&gt;</td>
<td>&lt;reg.name of referenced profile&gt;</td>
<td>&lt;reg.org&gt;</td>
<td>&lt;reg.version.m.n&gt;</td>
<td>&lt;requirement&gt;</td>
<td></td>
</tr>
</tbody>
</table>

6.4 Referenced registries
Table 2 lists the message registries referenced in this profile.

Table 2 – Referenced message registries

<table>
<thead>
<tr>
<th>Registry reference name</th>
<th>Registry identifier</th>
<th>Organization</th>
<th>Version</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>&lt;reg.version.m.n&gt;</td>
<td></td>
</tr>
</tbody>
</table>

6.5 Features
Table 3 lists the features defined in this profile.
Table 3 – Features

<table>
<thead>
<tr>
<th>Feature name</th>
<th>Granularity</th>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

6.6 Adaptations

Table 4 lists the class adaptations that are defined in this profile.

Table 4 – Adaptations

<table>
<thead>
<tr>
<th>Adaptation</th>
<th>Elements</th>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Classes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Indications</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

6.7 Use cases

Table 5 lists the use cases defined in this profile.

Table 5 – Use cases

<table>
<thead>
<tr>
<th>Use case name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

7 Description

<Insert Figure Here>

Figure 1 – <Profile Name Here>: Class adaptation diagram
8 Implementation

8.1 General

8.2 Features

8.2.1 Feature: <Feature name>

8.2.1.1 Feature description

8.2.1.2 Feature discovery

8.2.2 Feature: <Feature name>

8.2.2.1 Feature description

8.2.2.2 Feature discovery

8.3 Adaptations

8.3.1 General requirements

8.3.2 <Adaptation name>

8.3.2.1 General

8.3.2.2 Implementation requirements

Table 6 lists the element requirements of the <Adaptation name> adaptation.

<table>
<thead>
<tr>
<th>Element</th>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base elements</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Element</td>
<td>Requirement</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Properties</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Methods</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operations</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

8.3.2.3 Property: <property name>

8.3.2.4 Property: <property name>

8.3.2.5 Method: <method name>

Table 7 specifies the error reporting requirements for the <method name> method.

Table 7 – <method name>: Error reporting requirements

<table>
<thead>
<tr>
<th>Error reporting mechanism</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

8.3.2.6 Operation: <operation name>

Table 8 specifies the error reporting requirements for the <operation name> operation.

Table 8 – <operation name>: Error reporting requirements

<table>
<thead>
<tr>
<th>Error reporting mechanism</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Error reporting mechanism</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

8.3.3 Subclause Level 2 w/ TOC Entry
8.3.3.1 Subclause Level 3 w/ TOC Entry
8.3.3.1.1 Subclause Level 4 w/ TOC Entry
8.3.3.1.1.1 Subclause Level 5 w/ TOC Entry

9 Use cases

9.1 <Use case name 1>

9.1.1 Preconditions

9.1.2 Flow of activities

1) –

2) –

9.1.3 Postconditions

9.1.3.1 Success

9.1.3.2 Failure
ANNEX A
(normative)

<insert annex title here>

A.1 Annex Subclause Level 1 w/TOC entry

Table A-1 – <Table Title Here>

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

A.1.1 Annex Subclause Level 2 w/TOC entry

A.2 Annex Subclause Level 1 w/TOC entry

A.2.1 Annex Subclause Level 2 w/TOC entry

<Insert Figure Here>

Figure A-1 – <Figure Title Here>
## Change log

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&lt;yyyy-mm-dd&gt;</td>
<td>&lt;Include one row for each published release and each member review release (that is: Work in Progress, Draft DMTF Standard, DMTF Standard). In this “Description” column, note the document’s status and provide a summary of the changes since the previous release. The first release should not include a change summary. The summary of changes should be understandable for external readers that have no access to DMTF internal material.&gt;</td>
</tr>
<tr>
<td>1.2.2</td>
<td>2013-04-02</td>
<td>Various updates to custom styles (for example, hiding unused styles; removing font size from fixed font and hyperlink to make styles usable in other areas besides normal text; increasing space before/after table text)</td>
</tr>
<tr>
<td>1.2.3</td>
<td>2013-11-19</td>
<td>Replaced DMTF logo on cover page with new version created and approved by Marketing Committee.</td>
</tr>
</tbody>
</table>
Bibliography

DMTF DSP4004, *DMTF Release Process 2.4*,
http://www.dmtf.org/sites/default/files/standards/documents/DSP4004_2.4.pdf

<owning org><doc number>, <doc title and version or date>,
<hyperlink>